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VituixCAD マニュアル ～とりあえず動くからヨシ！～ 

 

ざっくりの流れ 

１．カタログのグラフから、ユニット特性データを作る。【Ｐ.2～】 

所要時間：初めて 2 時間、慣れてる 0.5h 

２．エンクロージャーを決める。バスレフ+ユニットの総合特性を出力する。【Ｐ.8～】 

  所要時間：初めて 2 時間、慣れてる 0.5h 

３．バッフルステップ補正のデータを作り、組み合わせる。【Ｐ.14～】 

  所要時間：初めて 2 時間、慣れてる 0.5h 

４．ネットワークを作る。【Ｐ.23～】 

所要時間：初めて 1 時間～、慣れてる 0.5h～ 

 

今回は、Fostex の FE103NV と PT20K を使った 2way の小型バスレフ型スピーカーをシ

ミュレーションで作製してみたいと思います。 

  

 

本方法は、メーカーで TS パラメーターが提示されている場合のみ有効です。 

ジャンクのユニットなど、全く素性の分からない場合は、自身で TS パラメーターを測定す

るひつようが出てきます。 

 

以前に発売された Fostex ユニット（FF105WK、FW108HS 等の現行品）は、下記の Fostex

インターナショナル web サイトから、詳細な TS パラメーターを探すことができます。 

https://www.fostexinternational.com/docs/speaker_components/speaker_line_up.shtml 

 

 

また、本マニュアル作成では、だし氏の下記資料を大いに活用させて頂きました。ありが

とうございます。 

https://docs.google.com/document/d/e/2PACX-1vQkFmzwCmisKmjT5APJ7PoLkZEViowA7KEphKeW5

giXpht3NDzOP8a8PqYxPxEdmgXUZAYl2qtBgyrp/pub  
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１．カタログのグラフから、ユニット特性データを作る。 

 

 

ソフトを立ち上げます。 

 

  

左上の Tools から SPL Trace を押します。 

 

こんな画面が立ち上がります。 

 

 

お目当てのユニットのメーカーweb サイトで、特性グラフを入手してきます。 

 

FE103NV の web ページは、特性グラフが独立画像として掲載されています。 

そのため、画像の上で 右クリック→コピー を押して、グラフを PC に記憶させます。 



3 

 

  https://www.fostex.jp/products/fe103nv/ より 

 

そのまま、VituixCAD の画面（SPL Trace）に戻り、Ctrl+V を押すと、画像が読み込まれ

ます。 

 

 

ちょっと上手くいかない場合は、グラフ画像を png や jpg ファイルとして一度保存し、そ

れを File→Open image で呼び出すと良いでしょう。 

 

 

Fostex の P1000K のように、PDF ファイルでしか特性が見られない場合は、①上手く PDF

からコピーで切り出す ②PrintScreen 機能で画像ファイル（png、jpg 等）を作ってから、

上記の方法で取り込む 等ができると思います。 
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グラフを取り込んだら、VituixCAD にグラフを認識させるためのガイド（色線）を適当な

位置に動かします。ドラッグで動くので、適当に合わせます。 

ツイーターの場合、中音～高音のグラフになっているので、緑枠内を適当な値（例えば

2000Hz など）に変えて対応します。 

 

 

できました！ 

 

このグラフでは、インピーダンスは log 軸となっているので、「Logarithm」が選択されて

いることを確認しましょう。ここは忘れずに確認です！（赤枠） 

★「Linear」10、20、30、、、Ωが等間隔になる縦軸 

★「Logarithm」4、8、16、32、、Ωが等間隔になる縦軸 



5 

 

 

左側の「×Grids」（赤枠）を押し、その後グラフ内をクリックすると、 

グラフ内の補助線が消えます。 

 

次に「Trace SPL」（青枠）を押し、周波数特性のグラフ（線）をクリックします。 

 

押したところに沿って赤線が出現し、グラフがトレースできます。一回では上手く読み込

まれないので、赤線が出ていない場所をポチポチ押して認識させます。 

 

今回は、グラフにはない 20kHz 以上が認識されてしまいました。グラフと混同されやすい

所にある文字が周波数特性として認識されてしまったようです。これを防ぐために、事前

に「ペイント」等のソフトで余計な情報を消しておくと良いかもしれません。特に、点線

で描かれる軸外特性の読み込みは、事前の画像編集が重要になるでしょう。 
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上手く認識できたら、左下の「Exprot」を押して周波数特性のデータを出力します。適当

な場所にファイルを保存しておきます。ユニット名を名前に追記しておくと、分かりやす

いと思います。 

 

インピーダンス特性は、右側の「Trace Z」と「Exprot」で同様に行います。

 

ここでは、「ペイント」ソフトを使って、余計な線を消した＆薄い線を実線で手書きしたグ

ラフを使いました。 

 

インピーダンス特性は、特に高域の軸外特性と重なって描かれているため、事前の画像処

理がないと、こうして荒ぶってしまいます。 
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おつかれさまでした。 

ひとまず、FE103NV の周波数特性とインピーダンスの、二つの txt ファイルが出来上がり

ました！ 

 

ソフトウェアは、一度立ち下げても構いません。 

ここで一休憩するのもアリですね。 

 

 

同様の手順で、軸外特性（30°）も同様に出力しておきます。 

また、ツイーターとして使う PT20K のデータも作成しておきます。 

 

周波数特性は、軸上（0°）と軸外（30°）の双方を見比べながら作り込んでいくのが大切

だと考えています。そのため、可能な限り軸外特性もデータとして作成しておくことが望

ましいでしょう。 

 

いま、私の手元には、以下の 6 つの txt ファイルが揃っています。 

・FE103NV の周波数特性（軸上 0°） 

・FE103NV の周波数特性（軸外 30°） 

・FE103NV のインピーダンス特性 

 

・PT20K の周波数特性（軸上 0°） 

・PT20K の周波数特性（軸外 30°） 

・PT20K のインピーダンス特性 

 

  



8 

 

２．エンクロージャーを決める。バスレフ+ユニットの総合特性を出力する。 

 

次は、エンクロージャーの設計です。 

今回は、バスレフ型のエンクロージャーを作っていきます。 

 

まずは、VituixCAD の初期画面から、Tools→Enclosure を選びます。 

 

 

画面がいろいろ出てきますが、まず、目的のウーハー（フルレンジ）ユニットが一覧にあ

るか探してみます。 

 

今回は「Fostex FE103NV」を使うのですが、残念ながら画面上部のユニット一覧にはあり

ませんでした。（2020 年 4 月現在） 

 

そこで、ユニットの追加（赤枠をクリック）を行います。 

 

なお、今の作業は、TS パラメーターに基づくバスレフ箱の設計なので、高音を担当するツ

イーターは関係ありません。また、先ほどグラフを読み込んだファイルも関係ありません。 
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Fostex の web ページにある TS パラメーターを見ながら、表を埋めていきます。 

ここでは、FE103NV のデータを入力します。 

 

（画像右側）https://www.fostex.jp/products/fe103nv/ より 

 

ここで、注意ポイントが 3 点あります。 

■（赤枠）Rms について■ 

Rms=1/Qms*√Mms/Cms です。 エクセルでは、下記のように計算できます。 

 

 

■Sd について■ 

Sdは振動板断面積です。FE103NVのWebページには「Equivalent Diaphragm Radius (a)」

と振動板の有効半径(mm)が書かれていますので、そこから円の面積(cm2)を求めます。 

 

■（青枠）Basic Z model について■ 

もしかしたら、記入不要かもしれません。 

 

全ての記入が終わったら、ＯＫを押します。後で書き直すこともできるので、もし間違っ

てしまっても大丈夫です。  
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TS パラメーターの入力が終わり、先ほどの画面に戻ってきました。 

入力した「FE103NV」が一覧表に追加されたと思います。 

 

今回は、バスレフ箱なので、「Bass reflex」を選びます。 

 

 

タブ「Enclosure」をクリックすると、「箱の容量」や「ダクト長さ・直径」の調整ができ

る画面が出てきます。 
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ひとまず、容量は 4L、ダクトの長さは 4cm、ダクトの直径は 2cm、としてみます。 

 

緑枠のところに「Area [cm2]」と出てきている場合は、ダクトの断面積を入力する状態で

す。チェックボックスを外せば、内径（直径）入力モードになります。適宜使い分けると

良いでしょう。 

 

あとは、自分の経験と勘で数値をいじります。 

左上の「SPL」と書かれたグラフに、周波数特性が出てきますので、それを見ながら調整

します。 

 

 

 

今回は、容量は 7L、ダクトの長さは 2cm、ダクトの直径は 2cm、共振周波数は約 61Hz と

しました。これは、FE103NV を試聴したときの感触や、歴代 FE103 を使ってきた経験か

らの値です。  
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実は、もっと賢く、全て自動で計算してくれる方法があります。 

 

 

Align タブで、適当な設定値を選び、Auto align のチェックマークを入れると、自動で箱容

量、ダクトの長さが計算されます。 

※自動計算すると、手動で入れた値（容量、ダクト長）は上書きされます。 

 

ここで、Table の中の 3 つの選択肢の意味を説明すると… 

 

「SBB4～」 ユニット（裸）の共振周波数と、ダクトの共振周波数が同じ。比較的大

きなエンクロージュア容量に計算され、過渡特性が良いと言われる。 

「QB3～」 比較的小容量の箱で、ダクト共振周波数を低くとる計算方法。 

「SC4～」 「SBB4～」に近いが、Qts が小さいときに異なった結果が出てくる。 

 

上記の詳細は、書籍「自作スピーカーエンクロージャー設計法 マスターブック」の p.90

（初版）をご参照ください。 
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比較的良さそうな感じになってきたら、右上の「SPL」「Impedance」をそれぞれクリック。

シミュレーションした周波数特性とインピーダンス特性を出力して保存します。 

 

せっかく箱特性を計算したので「Project(ﾌﾛｯﾋﾟｰﾃﾞｨｽｸのﾏｰｸ)」を押して、生データを保存し

ておいても良いでしょう。 

 

 

おつかれさまでした！ 

 

ユニットの TS パラメーターと、ダクト設計から求めた周波数特性＆インピーダンス特性の

二つの txt ファイルが入手できました。 
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３．バッフルステップ補正のデータを作り、組み合わせる。 

 

さて、ここからは少しアナログです。 

先ほど、箱容量を 7.0L としましたが、「どのようなエンクロージャーデザインにするか」

を考える必要があります。 

 

箱のデザイン（寸法）は、音の回折効果を引き起こすため、スピーカー周波数特性に変化

をもたらします。これを「バッフルステップ特性（Diffraction）」と呼びます。 

 

このステップでは、この「バッフルステップ特性」をシミュレーションします。 

そのため、先に寸法を決定しおく必要があるのです。 

 

 

とりあえず、容量 7.0L に、板厚を加えて、、、 

高さ 30cm、幅 14cm、奥行き 25cm というデザインにしようと思います。 

 

 

寸法が決まったら、シミュレーション開始です！ 
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Tools→Diffraction をクリック。 

 

 

以下の数値を記入します。 

Snap ：5mm 

Width：140mm （バッフル幅） ※画像では誤って 150mm となっています。 

Height：300mm （バッフル高） 

Edge rad.：0mm （バッフル端をラウンド加工する場合は、ここの値を適宜調整。） 

Sd：50.24 （TS ﾊﾟﾗﾒｰﾀｰの所で入れた、ユニットの振動板面積。概算値で OK。） 

Count：1 （ユニットは１つ。） 

 

入力が終わったら「New」をクリック。 

左側に図面が出てきます。 

 

円形マークをドラッグで動かして、ユニットの位置を決めます。ここでは「FE103EN」の

位置とします。 

ユニットの位置を変えると、右側のグラフの特性がリアルタイムで動いていくのが面白い

ですね。なお箱の形も、図面を動かして調整できます。 

 

マイクの形をしたマークは、推奨のリスニング高さに配置します。ウーハーとツイーター

の間、ツイーターの軸上など、適当に決めます。 
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ユニット位置に応じて特性が如実に変わってきますが、迷っていても仕方ありません。 

そもそも今回の実践例は、カタログスペックスペックを参照しているので、余り精度は期

待できないのです。 

 

決まったら「Exprot」を押して保存します。 .txt ファイルが生成されます。ファイル名は

「dif_WO」とかが良いでしょう。  （注意）SAVE では txt は出力されません。 

 

ツイーターの特性も忘れずにシミュレーションします。 

こちらのファイル名は「dif_TW」としました。 

 

おつかれさまです！ これで、バッフルステップ特性の txt ファイルが手に入りました！ 

 

※なお、【軸外】のバッフルステップ特性もシミュレーションできますが、カタログ値の周

波数特性（軸外）と重複する要素がどこまであるか不明なので、あえて実施しませんでし

た。興味のある方は、ぜひ突き詰めてみてください。 
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こうして得られたバッフルステップ特性データを、先にカタログから認識させた周波数特

性と合成します。 ※TS ﾊﾟﾗﾒｰﾀから求めた箱特性は、合成させる必要がありません。 

 

 

Tools→Calculator をクリック。 

 

A responses に「FE103NV の周波数特性（カタログより読み込み、軸上 0°）」の特性、 

B responses に「バッフルステップ特性」の特性を入力。 

 

 

気を付けるポイントは、赤枠の 3 点。 

・B responses の Scale dB に「－6.0」と入力する。 

・Multiple output は、「Multiply A*B」とする。 

・出力先フォルダーを決める。（とりあえずデスクトップでもＯＫ） 

 

完了したら、右下の「Calculate＆Save」を押す。 

A responses に使ったファイルの末尾に「～mul」と名前が追記されたファイルが生成する。 
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同様にして、以下の 7 つの周波数特性、3 つのインピーダンス特性が得られたと思います。 

 

＜周波数特性＞ 

①FE103NV（0°）のカタログ値+バッフルステップ込み 

②FE103NV（30°）のカタログ値+バッフルステップ込み 

③FE103NV の TS ﾊﾟﾗﾒｰﾀｰから求めた箱特性 

 

④PT20K（0°）のカタログ値+バッフルステップ込み 

⑤PT20K（30°）のカタログ値+バッフルステップ込み 

 

⑥バッフルステップ特性（ウーハー、FE103NV 用） 

⑦バッフルステップ特性（ツイーター、PT20K 用） 

 

＜インピーダンス特性＞ 

・FE103NV のカタログ値 

・FE103NV の TS ﾊﾟﾗﾒｰﾀｰと箱特性 

・PT20K のカタログ値 
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ここで、ウーハー（FE103NV）側の特性は、ユニットの特性（上記①や②）と箱の特性（上

記③）を組み合わせる必要があります。 

ユニットの特性は、カタログスペックから読み込んだものなので、バスレフ箱の効果が含

まれません。 逆に、箱の特性は、ユニットの中高域特性が考慮されていません。 そこ

で、適当な周波数で両者を合体させて、仮想のスピーカーとして完成させるのです。 

 

Tool→Merger をクリック 

 

 

上から、「ユニットのカタログ特性」「バッフルステップ特性」「箱特性」のファイルをそれ

ぞれ開きます。この処理は、ウーハー（FE103NV）のみ行います。 

 

最初は、二つのグラフにズレがありますので、200～500Hz のスロープが重なるように動か

します。動かすのは「ピンクの縦軸」と「Scale」の二つです。 

ピンクの縦軸は 300Hz 付近に、Scale は±2dB 以内に収まるはずです。 
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※追記 3 つのファイルの読み込みで、戸惑うことがあるので詳細を書きます。 

 

 

まずは、Low frequency part のところに、箱の特性（上記③）を入れます。 

こんな感じの、素直な特性が出てきます。 

 

次に、Diffration response のところの「〇」にチェックを入れ、 

バッフルステップ特性の txt ファイル（上記⑥）を入れます。 

 

バッフルステップ特性が加算され、うねっとした感じのグラフになります。 
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最後に、カタログから読み込み、バッフルステップ特性を加えたデータ（上記①、末尾 mul

と書かれたファイル名）を入れます。 誤って、カタログスペック素のままの特性を入れ

ないように注意しましょう。 

 

そして、間違いなく入力しても、エラーがでます。 

 

 

どうやら、「軸上特性が見つからねぇぞ！」とお怒りのご様子。 

とりあえず OK を押して、その後の画面で「Axial」に☑を入れます。 

（もっとスマートな方法があるのかもしれません。） 

 

 

 

これで、ファイルの読み込みが完了です。 

 

 

～追記終わり～ 
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イイ感じに合成できたら、Save を押してファイルを出力します。 

この時、下記の Destination directory のフォルダーに、一瞬でアウトプットされますので、

ファイルを見失わないよう気を付けましょう。 

 

同様に行い、⑧と⑨を作成します。ファイル名は「～mrg」となっているはずです。 

 

＜周波数特性＞ 

⑧FE103NV（0°）のカタログ値+バッフルステップ込み+箱特性合成済 

⑨FE103NV（30°）のカタログ値+バッフルステップ込み+箱特性合成済 

 

 

いよいよ役者は揃いました！ 

ネットワークのシミュレーションを始めましょう！！ 
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４．ネットワークを作る。 

初期画面のところで、今まで作ってきた特性（周波数＆インピーダンス）を入力します。 

まずは、FE103NV からやってみましょう。 

 

 

周波数特性（上記⑧）、インピーダンス特性（箱特性）をそれぞれ開きます。 

 

 

右側のグラフは何も変化しませんが、気にせず、Drivers のところに名前を入力します。 

 

FE103NV の軸上特性なので、名前は「FE103NV _00deg」にしましょう。 入力後、何か

聞かれますが、気にせずＯＫを押します。（大丈夫か？） 
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同様に、ツイーターも入力しましょう。 

 

緑の「＋」マークを押します。 

ツイーターは、バッフルステップ特性込みのファイル（上記④）を読み込みます。 
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同様に、軸外特性も追加していきます。 

その際は、ここに軸外特性であることを記入します。 ←良く分かりませんでした… 

 

 

同様に、「FE103NV（軸上）」「FE103NV（軸外 30°）」「PT20K（軸上）」「PT20K（軸外

30°）」の特性を入れます。  

入れ終わったら、ファイル名を改めて参照して、ウーハー（FE103NV）には「～mul mrg」

というﾊﾞｯﾌﾙｽﾃｯﾌﾟ＆box 特性が合成済のもの、ツイーター（PT20K）には「～mul」という

ﾊﾞｯﾌﾙｽﾃｯﾌﾟのみ合成済のものが、それぞれ入っていることを確認します。 
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いよいよシミュレーションスタートです。 

Crossover タブをクリックします。 

 

 

まずは、回路図中のユニットと電源（アンプ）マークを、一本の線でつなぎます。 

入力したユニットをそれぞれ選択し、違和感のない特性か確認します。 

 

 

「入力したのに、下のDriverプルダウンに名前が出てこないぞ」という場合は、一度Drivers

タブに戻り、緑の「＋」ボタンで適当なユニットを一つ追加します。おそらく、更新され

るはずです。 

  



27 

 

では、ネットワークを組んでいきましょう。 

先ほどの配線等、部品を消したい場合は、右クリックで Delete を選べば消せます。 

 

 

一つずつ部品を配置しても良いですが、パパッと入力する手段もあります。 

 

「LIB（ライブラリ？）」ボタンを押すと、代表的なネットワークが表示されます。 

ここでは、ウーハーのネットワークを作りたいので、右列から「Passive」「Low」の二つを

選びます。ツイーターの場合は「Passive」「High」を選びます。 

 

図表で出てくるのは電気回路としての書き方なので、「マイナスの配線」が描かれていませ

ん。私のような電気系未経験の、生粋の自作派にはちょっと慣れるまで時間がかかるかも

しれません。マイナスはグラウンドで全部繋がっているという考えなのです。 
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様々なネットワークがありますが、使いやすい「二次のネットワーク」を選んでみました。 

 

こんな感じに特性がでてきます。 

もし変な特性になったら、下の Driver から目的のユニットが選ばれているか再確認してみ

てください。 

 

ツイーターも同様に行います。ユニットのマークをクリックして、適宜配置します。 

  

 

注意点は、グラウンドを取り付けないと、ユニットから音が出ないところです。 
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さて、形として回路は組めましたが、まだ特性はガタガタだと思います。 

ネットワークの最適化が必要です。 

 

まず、ツイーターを逆相にします。 

 

ツイーターを右クリックして、Invert のところにチェックを入れると、逆相になります。 

 

次に、ツイーターの音圧を調整します。 

今回は作りやすい抵抗一本の調整回路です。 

 

今回は、3.9Ωとしてみました。 

私の感覚だと、この抵抗値（＝ツイーターの音圧レベル）は、後述の自動最適化より個人

の感覚でやった方が良いような気がします。 
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この VituixCDA の素晴らしいところは、ネットワークの最適化が「自動で」できることで

す。 

 → だかしかし、今回は諦めましたｗ P.32 へ飛ぶ。 

 

まず、WO（FE103NV）の回路の最適化を行います。 

最適化を行う回路を指定するために、WO につながれた回路を Control を押しながら、ク

リックして選択します。 

その後、Control を押したまま「q」を押す（Control+q）と、緑色のマーキングがされま

す。 

 

もし間違って押してしまったら Control+e で解除できます。 

 

 

次に、ツイーターをミュートするために、ツイーターを選択して「Control+m」を押します。 
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この状態になったら、最適化スタートです。「Control+p」を押して、最適化画面を立ち上

げます。 

 

 

 

こんな感じの最適化画面が立ち上がります。 

 

今回はウーハーの回路なので、「High pass：None」「Low pass：Linkwitz-Riley」を選び

ます。 

   

次に、「SPL」「N」「f」を適当な形にします。 

「SPL」：目標の音圧。200～400Hz 付近の出力音圧の値が目安。 

「N」：目標特性の次数（傾き）。2 か 4 が一般的。 

「f」：いわゆるクロス周波数。 

 

ここをどの値にするかは、センスが問われるところですね。 
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いろいろやってみましたが、この自動化、使いこなしが難しいです（爆） 

特に、現代のネットワークで組まれることを前提に作られたユニットでないと、理想のネ

ットワークにはなかなか近づかないばかりか、特性上も不自然な結果になってしまいまし

た。（たぶん、使いこなし次第ですが…） 

 

今回のような場合は、既存のネットワークを基本として、自身のインスピーレーションに

任せてネットワーク回路を作っていったほうが良い結果が得られそうです。 

 

 

 

-終- 

このネットワークに到達するま

で、初めて触った VituixCAD

で 2 日程度でした。 

もし、手作業で試行錯誤してい

たら 1 ヵ月、いや、もっと時間

を掛けても到達しなかったかも

しれません。 

どこまでソフトウェアで進める

か、どこから手作業で頑張るか。

人それぞれの解があって良いと

思います。でも、食わず嫌いは

勿体ないかな？と思います。今

までのスピーカー製作からもう

一歩視野を広げたい方に、 

VituixCAD、お勧めします。 

 

2020.04.05 カノン 5D 


